Chapter 5

iPad Tips, Tricks, and Apps
iPad Button Basics:
Sleep/Wake button

When you lock an iPad, nothing happens if you touch the screen, but music continues playing
and you can use the volume buttons.
Lock iPad: Press the Sleep/Wake button.
Unlock iPad: Press the Sleep/Wake button.
Turn iPad off: Press the Home button or the Sleep/Wake button, then drag the slider.
Turn iPad on: Hold down the Sleep/Wake button for a few seconds until the red slider appears,
then drag the onscreen slider. Hold down the Sleep/Wake button until the Apple logo appears. If
you don’t touch the screen for a minute or two, iPad locks automatically. You can change how
long it takes the screen to lock, or set a passcode to unlock iPad.

Home button

The Home button lets you get back to the Home screen at any time. It also provides other
convenient shortcuts.
To display the multitasking bar to see recently used apps: double-click the Home Button and
swipe to the right.
To close open apps: Touch and hold the app icon until it begins to jiggle, then tap . The app is
added to the recents list again, the next time you open it.
To display audio playback controls: double-click the Home Button and swipe to the left.
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To access audio playback controls when running an app: Double-click the Home button and then
swipe the multitasking bar from left to right.
To adjust the screen’s brightness: double-click the Home button to view the multitasking bar.
Flick from left to right, then drag the brightness slider.

Side Switch Button

To lock the screen rotation: Slide the Side Switch down to mute notifications, alerts, and sound
effects. This switch doesn’t mute audio playback, such as music, podcasts, movies, and TV
shows. In Settings, go to General > Use Side Switch to, then tap Lock Rotation.
To mute notifications, alerts, and sound effects: Slide the Side Switch. This switch doesn’t
mute audio playback, such as music, podcasts, movies, and TV shows.

Using multitasking gestures
You can use multitasking gestures on iPad to return to the home screen, reveal the multitasking
bar, or switch to another app.
Return to the Home screen: Pinch four or five fingers together.
Reveal the multitasking bar: Swipe up with four or five fingers.
Switch apps: Swipe left or right with four or five fingers.
Turn multitasking gestures on or off: In Settings, go to > General > Multitasking Gestures,
then tap On or Off.
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Syncing with iTunes
Syncing with iTunes copies information from a computer to iPad, and vice versa. You can sync
by connecting iPad to your computer using the Dock Connector to USB Cable, or you can set up
iTunes to sync wirelessly using Wi-Fi. You can set iTunes to sync music, photos, video, podcasts,
apps, and more. For detailed information about syncing iPad with a computer, open iTunes then
select iTunes Help from the Help menu.
Set up wireless iTunes syncing: Connect your iPad to your computer using the Dock Connector
to USB Cable. In iTunes, turn on “Sync over Wi-Fi connection” in the device’s Summary pane.
When Wi-Fi syncing is turned on, iPad automatically syncs every day. iPad must be connected to
a power source, both iPad and your computer must be on the same wireless network, and iTunes
must be open on the computer.
Tips for syncing with iTunes
If you’re using iCloud to store your contacts, calendars, bookmarks, and notes, don’t also sync
them to iPad using iTunes.
Purchases you make from the iTunes Store or the App Store on iPad are synced back to your
iTunes library. You can also purchase or download content and apps from the iTunes Store on
your computer, and then sync them to iPad.

Customizing the Home screen
You can customize the layout of app icons on the Home screen—including the icons in
the Dock along the bottom of the screen. You can create additional Home screens and arrange
your apps over multiple Home screens.
To rearrange icons: touch and hold any app on the Home screen until it jiggles. Arrange the
apps by dragging them. Press the Home button to save your arrangement.
To move an icon to another screen: While arranging icons, drag an icon to the right edge of the
screen until a new screen appears. You can return to a previous screen and drag more icons to the
new screen.
To create additional Home screens: While arranging icons, swipe to the rightmost Home
screen, then drag an icon to the right edge of the screen. You can create up to 11 Home screens.
The dots above the Dock show the number of screens you have, and which screen you’re
viewing.
To go to a different Home screen: Flick left or right, or tap to the left or right of the row of
dots.
To go to the first Home screen Press the Home button.
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To reset the Home screen to its original layout: In Settings, go to General > Reset, then tap
Reset Home Screen Layout. Resetting the Home screen removes any folders you’ve created and
applies the default wallpaper to your Home screen.

Organizing with folders
You can use folders to organize icons on the Home screen. You can put up to 20 icons in a folder.
iPad automatically names a folder when you create it, based on the icons you use to create the
folder, but you can change the name. Rearrange folders by dragging them on the Home screen or
by moving them to a new Home screen or to the Dock.
To create a folder: Touch and hold an icon until the Home screen icons begin to jiggle, then
drag the icon onto another icon. iPad creates a new folder that includes the two icons, and shows
the folder’s name. You can tap the name field to enter a different name.
To add an icon to a folder: When the icons are jiggling, drag the icon onto the folder.
To remove an icon from a folder: While arranging icons, tap to open the folder, then drag the
icon out of the folder.
To open a folder: Tap the folder. You can then tap an app icon to open that app.
To close a folder: Tap outside the folder, or press the Home button.
To delete a folder: Remove all icons from the folder. The folder is deleted automatically when
empty.
To rename a folder: While arranging icons, tap to open the folder, then tap the name at the top
and use the keyboard to enter a new name.

Changing the wallpaper
You can choose the images you want to use as wallpaper for your Lock screen and your Home
screen. Choose an image that came with iPad or a photo from your Camera Roll.
1.

In Settings, go to Brightness & Wallpaper, tap the image of the Lock and Home screens,
then tap Wallpaper or Saved Photos.

2.

Tap to choose an image or photo. If you choose a photo, drag or pinch it to position or
resize it, until it looks the way you want.

3.

Tap Set Lock Screen, Set Home Screen, or Set Both.
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Editing text
To position the insertion point: Touch and hold to bring up the magnifying glass, then drag to
position the insertion point.
To Select text: Tap the insertion point to display the selection buttons. Tap Select to select the
adjacent word, or tap Select All to select all text. You can also double-tap a word to select it.
Drag the grab points to select more or less text. In read-only documents, such as webpages, or
messages you receive, touch and hold to select a word.
To cut or copy text: Select text, then tap Cut or Copy.
To Paste text: Tap the insertion point, then tap Paste to insert the last text that you cut or copied.
Or, select text, then tap Paste to replace the text.
To undo the last edit: Shake iPad.

Speed up text entry with these keyboard tricks
Skip the period: When you get to the end of a sentence, press the spacebar twice to insert a
period and a single space.
Faster apostrophes: Instead of switching to the number-punctuation keyboard, just swipe up on
the comma key to insert an apostrophe.
Faster quotes: Swiping up on the period/question mark key inserts double quotes.
Simple insertion of special keys: Press and hold various other letters on the keyboard to access
such characters as the French soft c (as in"garçon"), the Spanish tilde n (as in "mañana"), and the
umlaut i (as in "naïve").
Broaden your punctuation horizons: You'll find a wider selection of punctuation marks by
using the same technique on the number-punctuation keyboard. For example, insert an upsidedown exclamation or question mark by swiping up (or pressing and holding) those respective
keys. Add ellipses by swiping up on the period key (only in the number-punctuation layout).
Insert various monetary symbols by pressing and holding the dollar sign, or swipe up on the zero
key to add a degree symbol. Perhaps my favorite of these shortcuts is the ability to add an emdash by swiping up on the hyphen key.
Activate--or disable--Caps lock: Tap either Shift key twice to type in all caps. If you want to
avoid accidentally switching to all-caps mode, deactivate the feature by opening Settings,
choosing Keyboard in the General category, and switching Enable Caps Lock to OFF.
Other options on this screen let you disable (or enable) auto- capitalization, auto- correction,
spell check, and the period shortcut. You can also choose from several dozen international
keyboard layouts.
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Using AirPlay to Broadcast your iPad screen
You can stream music, photos, and video wirelessly to an HDTV or speakers using AirPlay and
Apple TV. Your iPad and the the Apple TV must be on the same Wi-Fi network.
To Stream content to an AirPlay-enabled device: Start the video, slideshow, or music, then tap
and choose the AirPlay device. Once streaming starts, you can exit the app that’s playing the
content.
To quickly access the AirPlay controls: Double-click the Home button and swipe to the left end
of the multitasking bar.
To switch playback back to iPad: Tap

and choose iPad.

You can mirror the iPad screen (iPad 2 or later) on a TV with Apple TV. Everything on the iPad
screen appears on the TV (Great for watching the New Patriots on NFL.com).
To mirror the iPad screen on a TV: Tap at the left end of the multitasking bar, choose Apple
TV, and tap the Mirroring button that appears. A blue bar appears at the top of the iPad screen
when AirPlay mirroring is turned on.

Find My iPad
Find My iPad (download from the App Store) can help you locate a lost, stolen,or misplaced iPad
using an iPhone, iPod touch, or another iPad. You can also use Find My iPad using a Mac or PC
with a web browser signed in to www.icloud.com. Find My iPad uses Wi-Fi to locate your iPad.
If Wi-Fi is turned off or if your iPad isn’t connected to a Wi-Fi network, Find My iPad can’t find
it.

Viewing a Google Earth Tour
The new version of Google Earth for the iPad can read KMZ/KML tour files. Create the tour in
Google Earth on your laptop or download a file from the Google Earth Gallery or a file you
found through Google Advanced Search, and then save the file in Dropbox or email it to
yourself. Switch to the iPad, find the file, and choose “Open in Google Earth.”
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Taking photos and videos
To take a photo: Make sure the Camera/Video switch is set to
also take a photo by pressing the Volume Up button.
To record a video: Slide the Camera/Video switch to
or press the Volume Up button.

, then aim and tap

, then tap

. You can

to start or stop recording,

When you take a photo or start a video recording, iPad makes a shutter sound. You can control
the volume with the Volume buttons or the Side Switch. A rectangle briefly appears where the
camera is focused and setting the exposure. When you photograph people, iPad (3rd generation)
uses face detection to automatically focus on and balance the exposure across up to 10 faces. A
rectangle appears over each detected face.
To zoom in or out Pinch the screen (back camera, in camera mode only).
To turn on the grid: Tap Options.
To set the exposure Tap the person or object on the screen.
To lock the exposure Touch and hold the screen until the rectangle pulses. Lock appears on the
screen, and the exposure remains locked until you tap the screen again.
To Trim a video: While viewing a video, tap the screen to display the controls. Drag either end
of the frame viewer at the top of the video, then tap Trim. If you choose Trim Original, the
trimmed frames are deleted from the original video. If you choose “Save as New Clip,” a new
video clip is saved in your Camera Roll album, leaving the original video unchanged.
To take a screen snapshot: Press and release the Sleep/Wake button and the Home button
at the same time. The screenshot is added to your Camera Roll album.

Restarting and resetting iPad
If something isn’t working right, try restarting iPad, forcing an app to close, or resetting iPad. If
you can’t turn off iPad or if the problem continues, you may need to reset iPad.
To restart iPad: Hold down the Sleep/Wake button until the red slider appears. Slide your finger
across the slider to turn off iPad. To turn iPad back on, hold down the Sleep/Wake until the Apple
logo appears.
To Force an app to close: Hold down the Sleep/Wake button on top of iPad for a few seconds
until a red slider appears, then hold down the Home button until the app closes.
To Reset iPad: Hold down the Sleep/Wake button and the Home button at the same time for at
least ten seconds, until the Apple logo appears.
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My Story gives children a way to share stories by creating a recorded
storybook on the iPad. Draw, write, and record your stories with an easy-touse interface for all ages.

PuppetPal: Perfect for digital storytelling projects, PuppetPal allows the
student to choose characters (including photos of themselves) and
backgrounds, drag them onto a stage, and add animations and voice
recordings. Create your own unique shows with animation and audio in real
time. Export the movie and upload to a YouTube channel to share the video
with the students in the class. This is a free App but you can buy the
director's pass for $2.99 and receive all content.
The Fantastic Flying Books of Mr. Morris Lessmore has been regarded by many as the most
creative use of the iPad. Morris Lessmore hit the number one spot on
Apple's iPad app chart, becoming not just the bestselling book but the
bestselling App of any kind. It has been called "the best," "visually
stunning," and "beautiful" in a NY TImes review and "the most stunning
iPad app so far" according to MSNBC. The Times UK predicted that "The
Fantastic Flying Books of Mr. Morris Lessmore will be regarded as one of
the most influential titles of the early 21st century." It is a children's story
inspired by Hurricane Katrina, Buster Keaton, The Wizard of Oz, and a love for books. The text
can be changed to French or Spanish.
Explain Everything is an easy-to-use App that lets you annotate, animate,
and narrate explanations and presentations. Create interactive lessons,
activities, assessments, and tutorials with Explain Everything. You can even
use Explain Everything as an interactive whiteboard. Explain Everything
will record on-screen drawing, annotation, object movement and captures
audio via the iPad microphone. You can import photos, PDF, PPT, and
Keynote files and then export the final product as as a movie file to share.

VoiceThread: Now you can use, create, and share your VoiceThreads
directly on the iPad. Create conversations with your students around
documents, snapshots, diagrams, and videos. You can talk, type, and draw
directly on the screen. You can share your VoiceThread with your students
and they can join the discussion from their iPhone, iPad, iPod touch, Mac or
PC. Add images from your iPad camera or photo library, flip through pages
and annotate them while you narrate, and then simply share with your
students.
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Skitch: Annotate, edit, crop and share images and screen captures. Skitch is great
for the flipped classroom, creating tutorials and highlighting specific aspects of an
image. It works great with Evernote.

Flipboard is a free App that was named Apple's iPad App of the Year and one of
TIME's top 50 innovations of 2010. Flipboard is a fast, and visually beautiful way
to flip through news, photos, videos, from many news sites, as well as content
from your Google Reader, Facebook, Twitter, and Flickr accounts. View your
media in a magazine layout that is easy to scan.You can subscribe to popular
publications like National Geographic, The New Yorker, Wired, and Rolling
Stone, or customize your Flipboard with sections created from your favorite news, people, blogs,
and topics.

The Waste Land App brings alive the most revolutionary poem of the last hundred years with a
21st century tool displaying a wealth of interactive features that illuminate T. S.
Eliot's greatest work. This digital edition respects the integrity of the original yet
offers spectacular new ways to explore the significance and influence of the poem.
Watch and listen to performances and readings of the entire poem, synchronized to
the text. You can even listen to an original recording by T. S. Eliot himself.
Understand the poem's many references and allusions with interactive notes
and examine original manuscript pages to see how the poem took shape. This iPad
app carries forward Eliot's vision and vividly demonstrates how literature can be illuminated by
the new digital medium.
National Geographic magazine presents 7 Billion: How your world will change,
to coincide with the arrival of the the human population reaching 7 billion people.
The app explores the challenges of a growing human population in a world of
limited resources and explains the demographic trends that got us here today and
how it will impact us tomorrow with informative videos, interactive maps, indepth articles, and stunning photography.
Take on the laws of physics in Touch Physics HD, an iPad game designed for
both children and adults, young scientists and AP Physics students. Draw shapes
with crayons in order to complete each level with the goal being to move a wheel
to a target space. You achieve this goal by creating shapes that interact with the
wheel.
MathBoard is an app for teaching addition, subtraction, multiplication and
division. Customizing the problems will make MathBoard appropriate for all ages
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from kindergarten, with simple addition and subtraction problems, to elementary school, with
multiplication and division. You can control the range of numbers and the amount of questions.
You can even assign a time limit per quiz. Students have a workspace to complete and show their
work and then answer the multiple choice questions or see step-by-step problem solving to help
them generate the correct answers.
LineTime is an innovative way to explore and learn about our history,
pulling information from Wikipedia to show you a graphical timeline of human
history. View the history of the world in an interactive timeline. Tap and zoom to dig
deeper and get more granular dates. Tap on a specific event to see the article and
details and easily jump to a related spot in time. You can go from a century-level
view to a day-level view simply by pinching and zooming the interface. You can
also search within a layer on top of the timeline, letting you filter the timeline to reflect only
events related to your search term.
Google Search: This App features search made easy on the iPad/iPhone with the
ability to search by voice and skip the typing, and provides access to Google
Goggles,allowing you to take a photo of what you see to find more information
about products, landmarks or famous paintings. To make your search decisions
easier, you can compare search results as web page snapshots in Instant Previews
mode.

Art Set allows everyone to create original art with a variety of virtual "papers,"
paints, crayons, pens, pencils, pastels, markers, and texturing and blending tools.
Additionally, Art Set allows the artist to paint over photos stored on the iPad. It is
fun even for the non-artist. This one is good for younger artists.

Waze is not just a free traffic & navigation app but social driving for your iPad and
iPhones. Get live community-contributed traffic information and road reports, as
well as notifications when approaching police traps, speed cams, heavy traffic or
hazards on the road; this is a free navigation system that will avoid traffic featuring
voice-guided, turn-by-turn guidance; and a real-time map with road monitoring &
automatic re-routing as conditions on the road change.
Stuck on Earth is designed for travelers, photographers, and daydreamers,
bringing you the best places in the world to visit, photograph, and
experience. Discover millions of amazing places to visit, finding the best
locations and photos. The app has an easy to use map interface that allows you to
zoom into any level in any country to find the best places to visit.
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The iTunes U app gives you access to complete courses as well as the world’s
largest digital catalog of free education content. Take free courses created by
instructors from leading universities and other schools. See all of the
assignments and updates from the instructor in one place, and check off
assignments as you complete them. Take notes and highlight text in iBooks and
see them consolidated for easy reviewing in the iTunes U app. Access course
materials, including audio, video, books, documents & presentations, apps, and
new iBooks textbooks for iPad.

Scribble Press is a book creation platform that allows students to imagine,
create, and share their own stories with great drawing and writing tools. Easily
create an eBook, by either writing your own or using one of over 50 story
templates. Make a book about any topic and instantly publish to the gallery or
share with friends anywhere in the world. The app offers 50 story templates,
over 500 drawing tools, including markers and stamps in a vast array of colors,
a sticker collection, book layout tools and the ability to easily share the final
product.
LifeForms is a free app that lets you fill out PDF forms and share them via
email or save them to your computer. Go paper-free with all of your documents.
You can also sign your forms with your finger or stylus pen or notes. Export
your documents to a Dropbox folder. This is an iPad-only app. You can save
your contact information, signature, or any other helpful word to your words
list so that you can quickly add text to the PDFs. Students can submit their
papers to you as a PDF and you can markup and edit with LifeForms and submit
the work back to your students.
Enjoy the excitement of creating stop motion animations, also called
claymation or stop action movies, as well as time lapse recordings
with iStopMotion. Use this app for digital storytelling to bring your characters
to life frame by frame. Each movie can contain hundreds of frames. You can
share the videos directly to YouTube or continue to edit in iMovie. For more
information, great examples, a forum and tech support go to boinx.com/
istopmotion/ipad

Avid Studio, a rival to iMovie on the iPad, is a terrific app for anyone who
loves filmmaking or just wants to try it out. It has more editing features and
effects than iMovie, and unlike iMovie for the iPad, it can import video from
the Mac. Some of the editing features include picture-in-picture, composite
video for layered looks, and trimming video and audio clips. This app, priced at
$4.99, is well worth the expense for anyone interested in producing
professional quality videos with an iPad.
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The Smithsonian Channel is dedicated to videos that explore the history of
our planet, life and culture. This app introduces a brand new way to watch, find,
and explore the Smithsonian's vast video collection. The app is filled with great
content across a wide range of topics, including Air & Space, Culture, History,
Science & Nature, and Kids. If you’re looking for a source of quality media
content on your iPad, this free app is definitely worth a look.

Readability, one of the most popular web-based reading platforms, has released
a free iPad app. First, download the Readability add-on for your web browser to
save articles and web pages. This will turn any web page into a clean singlecolumn reading view, just as a book. You will then be able to read the web
content on your terms, regardless of any connection to the web. Customize the
type size, contrast, and margins to your liking. Share the articles via Facebook,
Twitter, or email. Readability gives you an unlimited, searchable archive that
syncs on the web. As soon as you're done reading an article, simply tap it to archive.

Brian Cox’s Wonders of the Universe: Take a incredible 3D tour of the Universe with Professor
Brian Cox as your guide. You can journey up from the smallest particles, past
the moons and planets of the Solar System, out through distant galaxies to the
edge of the known Universe. Encounter seething Red Giants, beautiful
Nebulae, pulsing Neutron stars and a vision of a Black Hole, all rendered in
spectacular 3D. Professor Brian Cox provides mind-expanding insight in over
200 interactive articles pinned to the stars, planets, galaxies and other wonders
modelled in extraordinary 3D. The app contains over two and a half hours of
video from the BBC TV series Wonders of the Solar System and Wonders of the Universe. The
app also includes hundreds of infographics and images of space objects supplied by astronomy
experts, NASA and other space researchers.

MagicReader is a free iPad App that lets you read PDF documents and turn the
pages simply by moving your head. You just turn your head to the left or right
and MagicReader will move to the next or previous page. It will take a second,
but once the iPad detects your movement, blue stars show up in the bar up top.
When you see them, that means you can start turning your head to make the
page change. Just make sure not to accidentally turn your head while in view of
the camera or else you will find yourself re-reading or skipping a page. So if
you're reading while eating, cooking with a recipe, playing an instrument or researching through
documents while typing on a keyboard, MagicReader is an app for you.
DocsTeach.org, first released in September, 2010 by the National Archives,
started with a collection of primary source documents, interactive tools, and
activities created and shared by teachers. The iPad app has just been released,
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making this collection of custom-made lesson plans teaching history, civics, math, and science,
available for iPad users. Choose a historical era or topic to find an activity based on primary
source documents. You can access all of the National Archives documents, drawings, maps, and
photographs, as well as participate, create, and share DocsTeach activities.
Story Patch allows you to to create your own picture books. Use Story Patch's
clip art gallery or import your own photos into your books. Customize the
characters in the story by changing expressions and clothing throughout the
story. Story Patch has easy-to-use controls for making illustrations look exactly
the way you want. The stories can be saved in PDF format to be shared with
others. The app also contains story starters to help younger children develop
their stories. Simply answer the series of questions and Story Patch will do the rest, building a
story based on the responses.

Bump is a free and very neat App that allows you too share contact
information, photos, and contacts by simply bumping two iPhones or iPads
together. Open the Bump app on your phone, and after entering in your contact
information, hold your phone, and gently bump your device with another user.
Bump will do all rest, transferring the information that you wish to share from
your device to the other users device. By "bumping," you will be able to share
contacts, photos, find mutual friends, and sync the devices for easy transfer of
information moving forward. Other Apps have started to use the Bump Technology,
including Sticky Notes HD and Bump Pay.
GoClass works very well in a 1:1 learning environment for all levels. With
GoClass, you can create lessons and deliver them to your students. Include
annotated images, sketches, text, and video in the lessons. Create class rosters
so that you can keep track of the usage of the lessons by the students. Post
questions and poll your students. Once the students responses are gathered, you
can project the responses without showing student's names. The polling
becomes a terrific way to prompt discussions about the questions and materials
that you have presented to your students.

TinyTap is designed for young students but can be used by older students
and teachers of older students, as well. Create an online quiz, story or
interactive book with voice recordings and music. Add photos, take a picture,
record a narration. TinyTap can be used for world language classes, math, art,
and much more. This is a prime example of using a basic app in a number of
creative ways.
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Rover is a web browser app that works well with Google Docs and with Flashbased websites. It provides links to educational resources but it can just be used
as a web browser that can, on occasion, work better than Safari.
ShowMe allows young students and older students the ability to create, annotate
and record over one slide. Show Me can be used for a digital storytelling
project, for creating a tutorial for the flipped classroom or for an animated
demonstration or explanation of a topic. Slides are saved to their website,
allowing for easy access. Screenchomp and Educreations are similar apps. in
ShowMe, the file is no longer editable once you have recorded your narration.

Comic Life, an iPad version of the Mac app, allows the student to use photos
from the Camera Roll or take photos to place in a wide variety of comic strip
templates. Students can add text bubbles, format fonts, and play with a variety
of styles. Final products can be sent to the the Photo Library or shared via
email.
Toontastic is another comic strip creator, but this one guides the student
through the process with the setup, conflict, challenge, climax, and resolution of
the story arc. Students can draw their own background or use one of the
templates. Then they add characters or draw their own. They can then animate
each scene, record a narration, and add music, making this site useful for both
young learners and learners of world languages.
Sonicpics allows you to add pictures or take a picture and then record a
narration of your slideshow, great for explaining a lab experiment, documenting
a field trip, analyzing plant growth, or creating a tone poem.

Composer is another sophisticated book creation app, allowing you and your
students to create interactive, animated ebooks. You can add sound, movies,
special effects, and animations. Composer has a steeper learning curve than
other apps, but the product can be quite polished.

ifPoems provides audio narration of over 200 well-known poems, but the
coolest feature is the ability to record one’s own oral interpretation of the
poems.
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Inspire Pro, ArtRage, procreate, Brushes are all painting apps, each one with
a different style and focus. Art teachers should experiment with them all.

SketchExplorer, based on Geometer’s Sketchpad, provides the ability to drag,
manipulate and animate mathematics. This app does not allow for the creation
of these animations, but it does provide access to a gallery of animations to
explore. This can be used for all grade levels of math exploration.

Evernote is a note-taking and voice recording app that synchs with the free
app that can be downloaded to an iPad, iPhone, Mac, or PC. Evernote works
really well as a digital portfolio for all age students and for an assessment
portfolio for teachers to share with parents and to aid in grading and
commenting on student work. Evernote also synchs with Skitch, adding to its
versatility and utility.
Showbie allows a teacher to assign, collect, and review student work because
it is a cloud storage solution designed to enable students to drop work from
apps right into an online assignment folder. Create an account on the Showbie
website and then set up your class. Through the website or app, students can
share files quickly and easily, express their creativity through creating content
in apps for assignments, and hand in their homework using their mobile
device.
Creative Book Builder can create a multimedia book with videos, images,
hyperlinks, music, multiple choice quizzes, and voice recording. CBB allows
you and your students to record videos or insert one from YouTube. CBB can
convert Google Drive documents into book chapters. Books are then easily
exported to DropBox, Google Drive, and iBooks.
Leo’s Pad, a great educational app, is aimed at pre-schoolers and early
learners. Produced by Kidaptive-- a media and technology company dedicated
to creative storytelling and developed in collaboration with Stanford
University--the app offers several interactive adventures. Children design and
build a rocket with Leo(nardo da Vinci), Gally (Galileo Galilei), and Marie
(Curie) by tracing and sorting rocket parts, mixing rocket fuel, and guiding
the rocket through space. As a child completes activities, the app will measure
the user’s responses, automatically increasing or decreasing in difficulty to
create the optimal learning level for each user.
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iPad Program Considerations
• Revising the AUP: Consider use of iTunes accounts and apps, camera and video regulations,
game playing, video watching, audio recording of classes, peers, and teachers, jailbreaking, app
installation, iCloud and backups, insurance, carrying and storing, charging, security, AppleTV
and projecting iPads.
• Deployment and Management: app purchases and distribution, device ownership, apps
ownership, iTunes accounts and students younger than 13, updates, maintenance, 1:1 vs. carts,
appropriate ratio of iPads to students as suggested by grade level, time frame, best practices,
identifying sound educational apps, strategies for classroom management, strategies for faculty
evaluation of apps as an ongoing process, strength of network (particularly with use of Apple
TV), iPad memory issues particularly with the advent of etextbooks, faculty professional
development, keyboards and accessories, printing, strategies for app requests, evaluating
etextbooks, use of iTunes U, workshops for parents.
• Costs to consider: iPad model, case, insurance, apps, accessories (including keyboard and
stylus), infrastructure upgrade, Apple TVs and televisions, stipends to faculty for creating iPad
rich courses and iPad rich textbooks and course content, extra chargers, charging stations, extra
iPads as loaners, iPads for faculty, iTunes gift cards for faculty, HDMI projectors.
•Kinds of Apps needed: voice recording, PDF annotation, Whiteboard and Shared Whiteboard,
Annotated drawings, Photo Editing, Video Editing, Stop Motion Videos, Presentation,
Mindmapping, Note Taking, Essay Writing, Drill and Skill, Simulations, Screen Capture,
Geography, animated textbooks and books, Storytelling and story creation, Painting, variety of
browsers, Math and Science manipulatives, Book reading, Aggregators.
• Starter List of Apps: Garageband, iMovie, Keynote, Pages, Comic Life, Explain Everything,
Show Me, Screenchomp, Educreations, Google Earth, iAnnotate, PuppetPals, Kindle, iTunes U,
My Story, Rover, Brushes (or another Art app), Evernote, Whiteboard, Skitch, QuickVoice,
Voicethread, Skype, iStop Motion.
• Rethinking Curriculum: differentiated learning, Multimedia creation, always-on access to web,
always- on access to camera, video and voice recording, learning spaces shift away from labs,
expertise shift towards students, strategizing essay writing, constructing alternate assessments,
teacher and student-created textbooks, anthologies, class notes, lab reports, etc.
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iBooks Author Tutorial
Creating your eBook
The bulk of your text should be created prior to using iBooks Author, which should be
considered primarily a layout program and not a text editing program. You can, of course, add
and edit titles and captions, and the text itself, but your life will be much easier if you do the
writing in either MS Word or Pages. Organization is the key; put chapters in folders on your
desktop, ditto with images and videos. Images in folders can be dragged easily to create a
slideshow. Keynote presentations can be dragged into a widget, so download all Google Docs
presentations and create as Keynotes, ditto for all your PowerPoint presentations.
First, download iBooks Author from the Mac app store. This free download is not available for
the PC, so some PC schools are purchasing a few Mac laptops or desktops to aid in the process
of ebook creation. Students can construct their share of the book on a PC, and then all the pages
can be merged in Word on a Mac and then imported in to iBooks Author.
Step One: Choose your template. Don’t be concerned about the name or subject matter of each
template; the text is entered as placeholders.
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Step Two: Begin to customize the template by clicking on the on the options available on the left
hand sidebar. First, enter your book title by double-clicking within the title place holder text box.
You can format the text by using the usual text-editing toolbar that runs across the top.
Step Three: Change the book cover photo by dragging and dropping the desired image file onto
the photo place holder. If the photo does not fit into the dedicated area, drag the slider in the

“Edit Mask” box until the image is resized to fit. If you would like an introductory video, then
click on “Intro Media: and drag and drop your fit into the video place holder. Please note that
videos must be in .m4v format. Adding video to your iBook is also really easy; however, you
need to have the video in the right format. You can drag and drop your video into the iBook and
then edit the videos size and location within the book. If you get an error when you try and drop
the video into the book then that means the format is not correct. You can change the video to the
right format by opening the video up in Quicktime and then exporting the video to a format that
works on iPhones and iPads.
Step Four: Create your chapters. Delete the template chapters on the left toolbar, and Choose
Insert > Chapter from Pages or Word document. Choose the document to import, and click
Insert. The style sheet from your Pages or Word document is also imported. Choose the desired
layout. Once you have your text in the template you can adjust the formatting, add hyperlinks,
and much more. Instead of accessing the Insert Menu, you can simply drag a Pages or Word
document into the Book pane from the Finder. If you are trying to produce something really
simple with no chapters, set the first chapter as a preface by clicking the pop-up menu by the
page thumbnail. Then your ebook won't start with Chapter 1 on the iPad.
Step Five: Edit your text.
• Make sure you have given each title a name so that it shows up correctly in the table of
contents. You can do this by selecting the chapter on the left hand column. Right click
where is says chapter to the right and then select rename. Rename the chapter to
whatever you would like.
• You need to make sure that the book looks right from both orientations. At the top of the
page you will see a small icon that says orientation. Click on each and view the book to

make sure that everything looks right from both view points.
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Step Six: Plug your iPad into your computer and choose the preview option at the top. It’s
always best to preview your book on an iPad to make sure everything looks and interacts the way
that you desire. If your layout is only good in landscape, you can disable portrait entirely by
checking the box in the Document Inspector (Document tab).
Step Seven: Get Interactive. Click on the Widgets icon on the toolbar.

Choose one of the widgets. The media files can be resized, dragged and dropped into different
locations on the page, and cropped to fit your needs.

Step Eight: Publish your final product. Now that you have created your iBook, it’s time to
export it so it can be published. First you need to export your publication. Click on File and
choose export. Then choose iBooks from the menu. Give the iBooks file a name, choose a place
to save it, and click export.
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Displaying the iPad Screen
Teachers really want to the ability to display their iPad or their students' iPads on a projector
screen. Projecting on a large screen is great for demonstrations, simulations, explanations, and
showing examples. There are several ways this can be done in the classroom.
VGA Adaptor: If you do not need to move around the classroom or display student iPads, then
the VGA dongle is the most straightforward connector. Plug in the iPad as you would your
laptop. This method is cumbersome when walking around a classroom with a long cable attached
to the iPad and the adapter and cable add weight. Allowing students to display their iPads
requires disconnecting the dongle from one iPad and then re-connecting to another, creating a
certain lack of spontaneity.
Document camera (or USB camera): Again, if you do not need to move around the classroom,
then you can place your iPad in the document camera device, and project from the camera. One
advantage is that all apps will work as they are displayed and with some finagling, students can
display their iPad work.
If you want to wirelessly transmit your device's screen and audio so that you or your students can
walk around the room, then it gets more complicated. Apple's AirPlay feature, built into all iPad
2s and newer, works over Wi-Fi so you can roam around the classroom with your iPad in hand.
Any of the wireless options requires all devices to be on the same network.
Apple TV: Designed primarily for home use to connect to an HDMI television, the Apple TV can
connect to a projector. iPad can mirror wirelessly to Apple TV using AirPlay. The caveats: Apple
TV outputs HDMI only, so the school’s projector should have HDMI input; if the classroom has
an older projector, chances are that it will not have the necessary HDMI input. If that's the case,
then the additional need is for an HDMI to VGA adapter like the Kanex ATVPRO.
Connecting to a laptop or computer: Software is available to turn a Mac or Windows PC into an
AirPlay receiver. Download AirServer or Reflector (formerly named Reflection). The software,
installed on your computer, allows the iPad to be mirrored on the computer screen. Since the
computer is connected to a projector, the iPad screen shows on the projector. The advantage of
this method is that school’s do not have to purchase Apple TV’s or adaptors, while teachers can
still roam wirelessly and multiple students can access the Mac or PC to display their iPads for the
class to view. Not all apps will work flawlessly with this set-up, so you will need to experiment.
Both apps offer free trial downloads.
One major concern is the havoc the wireless methods can create. Apple TV, AirServer, and
Reflector do not always work well because AirPlay requires the device and the computer or
Apple TV to be on the same network. Often schools have different networks for mobile devices
and for PCs so AirPlay won't work. Also, AirPlay requires specific ports to be open on the
network and frequently they are not. By using these devices, the school is adding countless new
wireless transmitters to its network, causing bandwidth and connection issues. Also, by
installing AirServer on machines, some schools would have to restructure their VLANs, not
always an easy task. Sadly, none of the options is perfect.
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